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6 Cybertracker. Toma de datos, descargas
y exportacion de datos

e Prueba de app en el movil.
e Descarga de datos.

e Exportar a Excel.

e Exportar a Kml

e Exportar a Kmz

6.1. Cargar la aplicacion en el dispositivo

En el moédulo 3, vimos como instalarle la aplicacion CT en el dispositivo movil.
Ahora debemos instalarle la aplicacion que hayamos disefiado :

1. Vuelve al ordenador y abrete la aplicacion que hayas disefiado en el CT.

2. Asegurate que estas en el modo “Applications”:

Saltwater Count me
ea ater Country B

EWGGIS Help

III'Ill'l'rJﬁu.ptptli«:ati'[:trls - \ = Saltwater Country Patr... ~ !

X =

Delete Screen | Application Properti

Reports

v Applications

Elerments Froperties
creen & Acknowledgements S Cre
= =] Rangers on Patral M arm
=l wha else is there? (]

Luego le das a:

= Zoom 100%

] & | b

Layout Mode Edit User Lists Test Run | Install To Mobile Device

Te debe salir informacioén sobre la instalacion:

e o

CyberTracker was copied to the root folder of the device, Use an Android File
Manager to locate, install and run it. When this is complete, redo the Application
install.
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6.2. Aplicacion disefiada en el dispositivo movil

Vuelve al dispositivo y en APLICACIONES, PULSA EL ICONO DE CT y ahi debe
aparecer el listado de aplicaciones de inventario que tengas instaladas, al pulsarla
te la abre directamente la aplicacion correspondiente.

H‘i CyberTracker

Your application name

Consejos que aparecen en la web:

e Si la aplicacidon se bloquea, simplemente cierre la aplicacion y vuelva a
abrirla. Se abrira en el mismo lugar que quedo bloqueada.

e En los dispositivos inteligentes Android cuando haya terminado de rellenar
un cuadro de texto haga clic en la flecha hacia atras para continuar.

e Cuando tome una foto, de tiempo al terminal para procesarla (sobre todo
en dispositivos moviles). No empiece a pulsar otros botones.

e Desactive el GPS cuando no esté en movimiento o cuando no se esta
utilizando para ahorrar bateria.

6.3.Toma de datos y descarga en el ordenador

Como vimos en el médulo 5, para visualizar los datos tomados con el dispositivo
movil, es necesario previamente haber disefiado algun informe o Reports.

1. Abre la base de datos del CT en tu ordenador en la opcién de “Reports”:
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=} i it Wiew Tools Help

Report1 - Regeneracion *
0 ] = = 7
1 Elements Lty Mew Sightings ~ Delete Sightings  Add Phoka Mews Yiew

= .

Regeneracion | Matoral | Obzervaciones | Foto | Query 5

= Properties
2
MHame R egeneracion Lz
Date range All D ate Time FERSOR L PARCEL
Diate from 010141920 B 187142016 |14:03:43 RALUEL FARCELA
Date ta >3M1/2016 17120016 125718 H.":".E!UEL PARCELA
T7A12006 125313 (1A FARCELA
=l Inzpector
T of 7 1712006 | 12:68:31 RAGQUEL FARCELA
[P 4 1712006 1 1265:38  [AMA PARCELA
TFA12006 1258326 1AV FARCELA

2. Conecta por USB el dispositivo al ordenador

3. En el ordenador pincha en File> Download data from connected device o
Download data.

Es importante sefialar que si se modifica la ruta de los archivos (por ejemplo, el
nombre del disco duro al cambiar de ordenador, o de carpeta o bien el nombre
de la base de datos) no apareceran los registros tomados en campo. No hay que
preocuparse, puesto que se guardan en una carpeta situada en la siguiente ruta:

e C:\Documents and Settings\Administrador\Misdocumentos \
CyberTracker\ System\ Orphans

La ubicacién de estos archivos “perdidos” se puede consultar en el menu
“Tools>Data Recovery Console” en el que aparecen distintas categorias de

archivos que no han podido ser recuperados.
Data recovery console e

Oiphan data

“When data cannot reach its final destination because of an error, it is moved to the
Oiphans folder. This usually happens when the destination database has been
maved or the data could not be uploaded for & long period of time.

5 icf) found [ [ open oe:

Staging data

“when data is downloaded from the clisnt device, it is stored in & temparary or
staging location until it cah be uploaded into the right database. Sometimes the
upload doesn't happen, for example if the database is comupt.

0 flefs) found - Open folder

Dutgoing data

When data is designated for another location [e.g. an FTF site). it is placed into a
folder called into a folder called Outgoing. If data is in this location for too long, it may
mean that the server is not available or that the usemame/password is wiong,

ficfs found ([ [ 0penioe:

SD Card data

IFthe "Use SD card for backup' option is enabled for an application, then all data is
hacked up ta the SD card in addition to being stored in the main memory. Dock the
device and click "Download now' to retrigve this data.

Recover from PDA Open folder
Recover fiom deskiop
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También se pueden recuperar con este método la copia de seguridad que se
guarda en la tarjeta SD del teléfono si hemos configurado la aplicacion de esta

manera en Applications> Edit Applications >General.

Feliesupbiesieig kg
General | GRS | Field maps | Goto || History
Hame mup 284
Usze title bar

Large titles
Large zcroll bars

OOoEO

Large tabs

Element aliaz Element name

Kiosk mode

Simple camera

Dizable editing

Test time an startup

Reszet to start zcreen after sunc

OooEoOoOd

Reset screen on next

[Use 5D card for data backup)

birror all data writes to an available S0 card. Requires that a fast S0 card be installed on the device.

[ ok || cancel |

Para abrir estos archivos dentro de la base de datos del proyecto se utiliza
“File>Import” y buscamos el archivo que hayamos visto al explorar la herramienta
anterior.

6.4.Descarga de fotos

Se pueden descargar las fotos capturadas con CT, conectando el dispositivo al
ordenador y buscando la carpeta MEDIA dentro de la carpeta CT del dispositivo.
Sin embargo si lo hacemos asi no vamos a poder vincular la informacion
alfanumeérica a las fotografias.

Para descargar las fotos de forma que podamos vincularlas mediante su nombre
al registro correspondiente y por tanto a los datos asociados a esa fotografia,
coordenadas UTM, fecha, hora, etc, seguiremos los siguientes pasos:

1. Debemos incorporar un campo Foto en el Reports y el identificador interno
(id) que asocia automaticamente el programa CT a cada registro del tipo:
{665DF89A-A2F8-7C19-48ED-2A15A498E078}
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2. En el Report que hayamos disefiado para las fotos, mediante la opcién
“Export view” exportamos el informe en formato CSV.

3. Las fotografias quedan almacenadas en la carpeta ExportMedia dentro de
la carpeta de tu ordenador que dependiendo de como se haya instalado

puede ser:

¢ C:\Documents and Settings\Usuario\Mis
documentos\CyberTracker\System\ExportMedia

e C:\Users\usuario\Documents\CyberTracker\ExportMedia

Estas fotografias son nombradas con el id asociado a cada registro:
{665DF89A-A2F8-7C19-48ED-2A15A498E078}-1.jpg

4. Ese mismo nombre queda registrado en el CSV que podemos importar
desde Excel y que nos servird para vincular cada foto al resto de
informacion alfanumeérica asociada a cada registro.

A B c [ D [ € F G
pate  [|Time [v|Monte  [|Foto_id T Latitude [+ |Longitudd ~ |1d
28/01/2015 11:26:57 valdesequillo parcino 39,0659582 -6,3495112 {G6SDFE9A-AZF3-7C19-48ED-2A15A498E078)
28/01/2015 11:33:19 valdesequillo ovino 39,0638677 -6,8478141 [416C6C8S-FF8A-0010-46D6- IDFIF612E052}
28/01/2015 11:34:42 valdesequillo cebadero ovino 39,0628933  -6,847252 [F20ED37C-CICA-DB1F-SESB-4CL77F026989}
28/01/2015 11:35:18 valdesequillo Pastor 39,0630928 -6,8471927 [AEBC936-5974-FD17-65E2-A7BB08ETBILI)
28/01/2015 11:37:12 valdesequillo Camino principal 39,062947 -6,8471965 {FDB32D02-2C07-3314-614B-4B037360EC37}

H
v |Foto
{665DF83A-A2F8-7C19-48ED-2A15A498E078}-1.jpg
{416C6CB5-FFEA-0010-46D6-9DFIF612E052}-1.jpg.
{F20ED37C-C9C4-DE1F-5E5B-4C177F026989}-1.jpg
{AEBC9936-5974-FD17-65E2-A7BB0887B919})-1.jpg
{FDB32D02-2C07-3314-614B-4B037360EC37}-1.jpg

De esta forma podemos hipervincular las fotografias a la informacién alfanumérica
en diferentes aplicaciones que nos seran de utiidad para hacer consultas o

generar informes.
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6.5.Exportar a Excel

Exportando a Excel mediante la herramienta Export dentro del médulo Report,
podremos exportar el informe al programa Microsoft Excel.

[ fmm| =
[ =) 2 -‘ - =l ey
= =2 OO ZE1E 0 6
ings  Delete Sightings  Add Phata Mew View [ Yy Edit Yiew l Export View Manage Reports Applications  Download Data

Date & Time [ Persona (2| Estadilo [ Parcela 2 Regener B2 Otra esp 2 mayor de 1.30 [ menar de 2
» 07/11/2016 | 09:56:51 Jarge Regeneracian 155 pinus nigra g S e |
07/11/2016| 095659 | Jorge Regeneracin 155 quercus fagi| oz Egn T [2][%]
07/11/2016 036753 |Jorae Matorral 155 Il B Cybeitranker goneicn B osecmE
07/11/2016|09:53:38  |Jorge Observaciones 155
|07/11/2016 (085340 |Jorge Finalizar Faicela | 155 | 3
|07/11/2006 102350 |Jorge Fiegeneracién 166 pinus nigra | Le)
:UT/'H./‘ZUTB:'IU.ZS.SB ;Jurge Hegen_s!aclc'm .'IBB quercus ilex Drnec:;:atgt:s
071142016 10:30:07 | Jorge Regeneracion 1E6 quercus fagi i
[07/11/2006 103057 |Jorge Matarral 166 | B
07112016 [10:31:57 | Jorge Obzervaciones 166 Estrtons
07A1/2016|10:31:59  |Jorge Finalizar Parcela 166
07A11/2016|10:57:48  |Jorge Regeneracion 165 pinus nigra
|07/11/2016 105754 |Jorge Fiegeneracion 165 quercus et |
|07/11/2006 105802 |Jorge Fiegensiaciin 165 quercus fagi| | Mis documentas
|711/2mE 1053 |Jorge Matorral 185 |
|07A11/2076[11:0016 | Jorge Dbservaciones 165 -
07411,/2016|11:00:18 Jarge Finalizar Parcela 165 rj)-g
07142016 11:2603 | Jorge Fiegeneracion 164 pinus riigra MiFC.
07A1/2016|11:2610 | Jorge Regeneracion 164 quercus fagi
_07#11.1'2018_11'28'53 _Jnrge M atarral _184 | ‘_:1] Nor ] ardar
07A1/2016|11:27:563  |Jorge Obszervaciones 164 o =
[07711/2016 112753 |Jorge Finaliast Prcels. | 164 Mizstiozdered | T 1hd =ra
.UTH 142016 [ 11:57:41 :Jurge Regeneracion .183 pinus nigra | 17
071172006 115747 |Jorge Regeneraciin 163, quercus ez | | 2
N7A1 M E1-ET-EY larma Rananarsmisn 1R Anarens bam i

6.6.Exportar a Km|

Para exportar un dato en una tabla a Google Earth, seleccione el informe de
datos que desea exportar (Reports).

Seleccione "Export View', seleccione la carpeta donde desea "Guardar en',
escribe el "Nombre de archivo", y en "Guardar como tipo", seleccione "Google
Earth (Keyhole Markup Language)".

Si estd conectado a Internet, se pedira ";Le gustaria comenzar Google Earth?
"Seleccione" Si "para ver sus datos en Google Earth.

Si solo es visible uno de los datos, es por como esta configurado Google Earth.
Para ver todos los datos, es necesario ajustar en la barra de tiempo que aparece
al marcar Ver>Imagenes Histdricas, las fechas del inventario.

el | | | - e L = el B

ol 2002

s



) ) o Moédulo 6. Toma de datos,
Nuevas tecnologias para captura de informacion de campo -
descargas y exportacion de datos

6.7.Exportar fotos en kmz

Para exportar las fotos y poder verlas geoposicionadas en Google Earth,
tendremos que exportar el report en el que aparece el campo “foto” descrito en
el apartado “descarga de fotos” y seleccionar el formato kmz.

El formato .kmz es un formato de compresibn de archivos que te permite
visualizarlos de forma directa en Google Earth la informacién asociada. En este
caso se trata de una serie de puntos geoposicionados con una informacién
asociada entre la que se encuentra la fotografia.

Sin embargo el tamafio de las fotografias en Google Earth predefinido por defecto
es demasiado pequefio por lo que tendremos que modificar la descripciéon de los
elementos. Para ello tendremos que descomprimir el archivo .kmz. Esto se hace
modificando la extension del archivo y sustituyendo el .kmz por .zip. Luego se
descomprime y podemos ver que el archivo estaba compuesto por:

e doc.kml: es un archivo de Google Earth con la descripcion de cada uno de
los puntos.

¢ Media: es una carpeta que contiene las fotos vinculadas al archivo doc.kmi

Para cambiar el tamafo de las fotos tenemos modificar el comando que describe
esta propiedad y que podemos ver en Google Earth si miramos en Boton
derecho/Propiedades/Descripcion de cada uno de los puntos, donde aparece:

<table border="1">
<tr><th>Name</th><th>Value</th></tr>
<tr><td>Date</td><td>28/01/2015</td></tr>
<tr><td>Time</td><td>17:12:37</td></tr>
<tr><td>Monte</td><td>garabato</td></tr>

<tr><td>Foto</td><td><img src="media/{C2C3E976-808F-8813-4247-
32ED316D85FE}-1.jpg" height="100"/></td></tr>

</table>

Para modificar todos los puntos de manera simultanea, abrimos el archivo doc.kml
con el bloc de notas y mediante la opcién Edicion/Remplazar modificamos la
parte de la descripcion de los puntos que por defecto viene como height="100"
incrementando hasta height="400" por ejemplo.

10
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Luego se pueden volver a comprimir los contenidos a .zip y volver a modificar el
formato a .kmz si se desea.

[~ Google Earth - a

D ¥[7"
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¥ Search ¥
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